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Mise en contexte

» Les classeurs Excel de toutes les versions sont accessibles (97
a2010)

» La présentation se limite aux versions 32-bits de SAS (9.1 a
9.3), sous Windows, UNIX et Linux

» Les versions 64-bits de SAS supposent plusieurs changements
aux facons de procéder

¢ Harpy

1. Interfaces dans Enterprise Guide

> Les "aménagements" aux classeurs Excel (ajout de rangées au
début, conversion en fichier .csv, transformations Num < > Car
de colonnes, etc.) sont inutiles et laborieux.

» La lecture de certains plages dans les feuilles posera toujours
des problémes: graphiques, tableaux croisés dynamiques, etc.

» Importation tres souple - les utilisateurs de SAS sous Windows
(menus Import Data) ont toutes les raisons d'étre jaloux...

@ Haroy
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1. 1 Importation dans Enterprise Guide

» Sélectionner File > Open - Data dans les menus déroulants
ou encore, dans le flux de processus, puis du bouton droit de la

souris, sélectionner Open - Data

» Activer ensuite I'icobne Local Computer et trouver le classeur
Excel — le champ Files of type montre tous les types de fichiers

accessibles

@ Harpy

1.1 Importation dans Enterprise Guide (suite)

&= Open Data

Laok in: I“:' DATA

x|
i [ R = 5

)

Local Computer

Servers

L

545 Folders

Mom =

Taille: | Type

| Date de modification |

NS ConTRACTS.C5Y
CONTRACTS.DEF

A CONTRACTS XLS

B CONTRACTS_mad. 4L5
[BEXER _BD. MDB
@persz.x\s

Hlrers cav

PERS, DAF

TEST_AUSLLTAT 2L
HTEST_TOTO s

File name:

1Ko
1ko
11 ko
14 ko
208 Ko
11Ka
2ko
2Ka
22 ko
16 Ko
14 ko

Microsoft Excel Com...

Fichier DEF

Feuille de calcul Micr...
Feuille de caloul Micr....
Application Microsof ..
Feuille de calcul Micr...
Micrasoft Excel Com...

Fichier DBF

Feuille de caloul Micr....
Feuille de calcul Micr...
Feuille de caloul Micr....

2008-09-07 22:28
2008-09-07 22:25
2008-09-07 22:25
2009-06-12 09:33
2010-02-03 1454
2009-07-07 1546
2008-09-07 22:25
2008-09-07 22:28
2010-02-07 03:32
2009-05-07 11:32
2009-05-07 11:47

=

Files of type:

Al Enown Data Files [*sas7bdat.” sasThvew:” 5d2;" mdb.” accdb,” dbf:" Wls” slsw” H|SFJ

Cancel |

@ Horoy
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1.1 Importation dans Enterprise Guide (suite)

B
1 ofd  Specity Data Ssas

The Import Data task is uzed to convert non-SAS data into a SAS data fle which is required by ather tasks for data
analyzis and reparting

Source data file

Location: Local File Spstem
File path: C:\SASCOURSADATANPERS XLS
[ ata type: Excel “workbook

Output SAS data et

SA5 server Local (/Bm

Library: SASUSER 1
Data set: IPEHS

@ Harpy

1.1 Importation dans Enterprise Guide (suite)

> Boite de dialogue Import Data (diapo précédente) en 4 étapes

> Etapej 1: rappelle le classeur lu et le nom et I'emplacement
suggéré pour les données importees

» Cliquer sur Browse pour choisir une bibliothéque autre que
WORK ou la table SAS sera déposée - changer également, au
besoin, le nom de la table SAS créee

Output SAS data sst

SAS ocal Browse... I
Library: WORK 1
Data set FPERS

» Cliquer ensuite sur Next

@ Harpy




1.1 Importation dans Enterprise Guide (suite)

> Etape 2 - Feuille, zone ou plage de valeurs lues

» Cliquer sur la feuille désirée (ici PERS — un hasard que la
feuille porte le nom du classeur)

» Cliquer sur Use a predefined named range pour utiliser une
zone portant un nom prédefini, au lieu d'utiliser une feuille
donnée

> Si 1¢ ligne importée ne contient pas de noms de colonnes,
désactiver le choix First row of range contains field names

» Si des colonnes portent des noms non-standards, toujours

activer le choix Rename columns to comply with SAS
naming conventions

¢ Harpy

1.1 Importation dans Enterprise Guide (suite)

&1 Import Data from PERS.XLS

x|
2 ofd  SelectData Source

[ A3Elect range

& Use a workshest

I First row of ran

& contains field names
EMPLOYES_REVENLS

s to comply with S namin

[~ Use s specito rangs of cels vithin the %
warkshest

Topleft celt

Lawer-fight el

' Use s predefined named range

%
o

Help
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1.1 Importation dans Enterprise Guide (suite)

» Pour importer une partie d'une feuille, activer le choix a cocher
Use a specific range of cells within the worksheet et
specifier les cellules du coin supérieur gauche au du coin
inférieur droit

» Revérifier alors si le choix a cocher First row of range
contains field names doit demeurer actif

v |Jze a specific range of cells within the

anksheet [%
Top-left cell:
Lower-right cell:

Rezet Range
) " Use a predefined named range
¢ Harpy

1.1 Importation dans Enterprise Guide (suite)

> Etape 3 - Choix des colonnes et de leurs attributs

» La colonne Inc de gauche indique si la colonne correspondante
de la feuille sera importée

> La colonne Source name contient le nom Excel

» La colonne Name contient le nom SAS, qui différe du nom
Excel lorsqu'il contient des caracteres non-permis par SAS -
double-cliquer pour modifier ce nom

» La colonne Label contient le libellé SAS, soit par defaut le
nom Excel - double-cliquer pour modifier celui-ci

@' Haroy
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1.1 Importation dans Enterprise Guide (suite)

x|
3 of4  Define Field Atributes §Sas_

Select columnz and define attributes:

TN
. MATRICUL | MATRICUL Mumber
| ¥ [ HOM NOM NOM Sting $CHARS. g $CHARS. $CHARE.
[ |DEFT DEPT DEPT Mumber |BEST12. 8 BEST12. BEST12
I | W |POSTE POSTE POSTE String $CHARE. ] $CHARE. $CHARS.
! ¥ | AMMEES SMMEES | AMMEES Murnber  |BEST12, 8 BEST12. BEST12
1| W | SaLsIRE SALAIRE  |SALAIRE Mumber |BEST12. 8 BEST12. BEST12

1.1 Importation dans Enterprise Guide (suite)

» La colonne Type contient le type SAS (Num/Car)

> La colonne Source Informat fournit un format de lecture SAS
approprié pour chaque type de données

» La colonne Output Format fournit le format d'écriture SAS

» Les valeurs dans ces trois colonnes peuvent étre modifiées au
besoin

@ Haroy
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1.1 Importation dans Enterprise Guide (suite)
> Etape 4 - options avancées d'importation trés rarement utiles

» Latable SAS dont le nom a été fourni est créée en appuyant
sur le bouton Finish

¢ Harpy

1.2 Exportation dans Enterprise Guide

Trois maniéres de démarrer:

> sélectionner File & Export = Export nom-de-table as a
step in project dans les menus déroulants,

> cliquer sur la table SAS dans le flux de processus et du bouton
droit de la souris, sélectionner Export = Export nom-de-
table as a step in project,

> a partir de la visionneuse de données de la table, cliquer sur le
bouton Export et choisir Export as a step in project

» la méthode Export nom-de-table offre moins de flexibilité

l RESLLTS -

1 Filter and Sort £ Query Bulder | Data » Describe » Graph v Analyze @(port +)sendTa + | /]
@) STUDENT () TEACHER |4  SEX f@) AGE | TEST1 [&) T

@ Hamy i ¢ E—

=
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1.2 Exportation dans Enterprise Guide (suite)

» La boite de dialogue Export apparait

> Etape 1 - confirmer le fichier & exporter

77 Export (o]
1 of4  Selectthefileto export gsas

The export task allows a user to export a file and distribute the new file to ancther physical location. Some files
such as data and report files can be converted to a new type prior to saving.

Export even when emors oceur in the file

File To Export:

Name Type Source Cortainer Date Modfied -
[Z]Log SAS Log Fuile (AGE-.. FrocessFow  10/18/2013 65625
ElLog 5AS Log Feulle Types .. ProcessFow  10/16/20137:1206
Z]Log 545 Log Feuile Champ...  Process Fow  10/16/20137:20:55
[Z]Log SAS Log Assign Project... AUTOEXEC ~ 10/16/20138:25.02
[ZLog SAS Log Beport File [C..  Process Fow  10/16/2013 8:26:43
[Z]Log SAS Log Cree Donnes...  ProcessFlow  10/16/2013 84757 —
ElLog SAS Log Bipot Fle [D...  Process Fow  10/16/20139:01 35‘5‘
7 PERS Input Data Process Flow 10/16/2013 :31:27 8
< i, ] b

¢ Haroy

1.2 Exportation dans Enterprise Guide (suite)

> Etape 2 - sélectionner le type de fichier (ici Excel)
» Seul format Excel: classeurs 2007 (a vérifier)

2 Epont ==
2 of5 Select a file type for the output file. Ssas

Output File Type:
SAS Data Files (V7 Long Name) (*sas7hdat}
SAS Library Member ("sas7bdat)
SAS Data Files (V) ("sd2)
Text Files (Comma delimited) (".csv)
Tesd Flles (*td)
Text Files (Tab delimited) (" tab)
Text Files (Space delimited) (" bd)

[ T | »

«
y//’ HarDyecrfies the tvoe of file that vou want to export.
Z
SERVICES CONSEILS
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1.2 Exportation dans Enterprise Guide (suite)

> Etape 3 - exiger que les libellés de variables SAS (au lieu des
noms) deviennent les noms de colonnes Excel

EZY Export

==

¢ Haroy

3 of5  Modify additional options for the output file. S

Options

Use labels for column names

Sas

1.2 Exportation dans Enterprise Guide (suite)

> Etape 4 - indiquer le répertoire ol le classeur Excel sera créé
(habituellement dans Local Computer)

» Le choix a cocher Overwrite existing output fait en sorte de
remplacer un classeur de méme nom existant déja

¢ Haroy

Ef Export

(=)

4 of5  Specify the location and name for the output file. S

Qutput File:

@ Local Computer
C:\Users\Jean Hardy'\Documents\PERS xlsx

") SAS Servers

Output Options
Overwrite existing output

Sas

2013-11-04
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1.2 Exportation dans Enterprise Guide (suite)

> Etape 5 - revue des choix précédents

> Le bouton Finish lance la création du classeur Excel

» Nombreuses limitations:

pas de controle sur le type Excel des colonnes (les types
SAS sont généralement reconduits dans Excel)

pas de contr6le sur le format Excel des colonnes
pas de filtrage des colonnes exportées

une seule feuille par classeur, pas de contrdle sur son nom et
impossible d'exporter vers un classeur existant

etc.

@ Haroy

2.1 Importation dans SAS Windows

» Sélectionner File & Import Data dans les menus déroulants,
qui invoque l'application Import Wizard

¢ Haroy

5k Import Wizard - Select import type = |

What type of data do you wish to import?
] Standard daia source

Select a data source from the list below

Microsoft Excel Worlbook("ds *dsb *dsm “dsx) -

User-defined formats

Define  special file format using the Exemal File

|mwﬁ'§f]‘zard Interface: (EF) faciity

mpert
EXCEL data

2013-11-04
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2.1 Importation dans SAS Windows (suite)

» Sélectionner le répertoire et le nom du classeur Excel a
importer, dans la boite de dialogue Connect to MS Excel, via
le bouton Browse

Connect to MS Excel

Workbook: [y 5ASCOURS \pers.1ls

]9 Cancel

@ Haroy

2.1 Importation dans SAS Windows (suite)

» Choisir la feuille, au besoin, a I'aide de la toupie a droite du
champ What table do you want to import

I Import Wizard - Select table =] 3]

“what table do you want to impart?

MPLOYES_REVENLIS
E Options..

SAS
Impart Ywizard

— ‘what table do vou want ta impart?

EMPLOYES_REVENLIS =l

EMPLOYES_REVEMUS
EMPLOYES _REVENUSS

13

PERSE -

L

¢ Haroy

2013-11-04
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2.1 Importation dans SAS Windows (suite)

» Plusieurs choix derriére le bouton Options (sous le champ
What table do you want to import)

> Si 1¢¢ ligne importée ne contient pas de noms de colonnes,

désactiver le choix Use data in the first row as SAS variable
names

» Si une des colonnes est susceptible de contenir a la fois des
valeurs numériques et du texte, activer le choix Convert
numeric values to characters in a mixed types column

> Les autres choix sont rarement utiles

@ Harpy

2.1 Importation dans SAS Windows (suite)

SAS Import: Spreadsheet Options ﬂ
[¥ Use data in the first raw az SAS variable names.

[~ Corvert nurmenc valuss o characters in a mised tipes colurn,

[¥ Use the largest tewt size in a column as SAS variable length, Cancel

[v Use DATE. format for a Date/Time column,

v Use TIME. farmat if orly time values found in a colurnn,

The largest test zize allowed in a column; 1024

@ Horoy

13



2.1 Importation dans SAS Windows (suite)

» La prochaine étape fournit un nom a la table SAS créée

» Cliquer sur Browse pour choisir une bibliothéque autre que
WORK ou la table SAS sera déposée - fournir ensuite le nom
de la table SAS créée

E Import Wizard - Select library and member EI@

Choose the SAS destination:

Library:

WORK -

LOOooo

Member

¢ Harpy

2.1 Importation dans SAS Windows (suite)

> La derniere étape sert a sauvegarder dans un fichier .sas le
code généré par l'outil d'importation

» Utile lorsque plusieurs feuilles de classeurs apparentés doivent
étre importées

» Le bouton Finish terminer I'importation

@ Haroy

2013-11-04
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2.2 Exportation dans SAS Windows

» De la plupart des fenétres, choisir File > Export Data dans
les menus, ce qui invoque l'application Export Wizard
» Pour que les libellés de variables SAS (plutdt que les noms

SAS) deviennent les noms Excel de colonnes, activer le choix
Write variable labels as column names

E Export Wizard - Select library and member EI@

Choose the source SAS data sat:
Library:
[EDUC -
Member:
[PERS -

cAS Write vanable labels as column names

@ Haroy =

2.2 Exportation dans SAS Windows (suite)

» Au besoin, a l'aide de la toupie, sélectionner ensuite le type de
fichier Excel dans la liste

SAS
Export Wizard

Expot to
EXCELfile

@ Harpy

[t Export Wizard - Select export type e =)

What type of data do you wish to export?
Standard data sounce

Select a data source from the list below

Microsoft Excel Workboole{* xds *xdsb *dsm *xdsx)

[“TTMicrosoft Access 200x Database(" mdb - accab)
Microsoft Access §7 Database(" mdb)
Comma Separated Values (".csv)
Tab Delimited File {* txt)
Delimited File (".7)
dBASE File (" dbf)
JMP File {*jmp)
SPSS File ("sav)
Stata File (*.dta)
Paradox File (*.db)

Microsoft Excel 5 or 95 Workbook (*xds)
Microsoft Excel 4 Spreadshest (" ds)

2013-11-04
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2.2 Exportation dans SAS Windows (suite)

> Fournir ensuite la localisation et le nom du classeur Excel a
créer

» Siun classeur du méme nom existe, il se peut que la fenétre
suivante apparaisse - cliquer alors sur Replace pour le
remplacer ou sur Append pour y ajouter une nouvelle feuille

Save As l&_y

C\Exercices\PERS.XLS

This file already exsts.

| Replace || Append | Cancel

¢ Harpy ‘

2.2 Exportation dans SAS Windows (suite)

» De retour dans la boite de dialogue Connect to MS Excel, si
un classeur du méme nom existe et doit étre remplacé, cocher
le choix Replace with a new Excel file if it exists

> Pour écrire une feuille additionnelle dans un classeur existant,
ne pas activer ce choix

*8 Connect to MS Excel (=23

Workbook:  [c\ Exercices'\PERS XLS

| Replace with a n&ﬁ Excel file f it exdsts.

@ Haroy

2013-11-04
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2.2 Exportation dans SAS Windows (suite)

» Taper le nom de la feuille Excel, dans le champ Assign a name
to the exported table

» La derniere étape ne sert qu'a sauvergarder dans un fichier .sas
le code généré par I'outil d'importation

» Cliquer sur Finish pour terminer I'exportation

E Export Wizard - Select table EI@

Assign a name to the exported table:

f// Hamy - 2

3. PROC IMPORT et PROC EXPORT

» Procédures qui permettent d'automatiser les étapes illustrées
dans les interfaces pour EG et pour SAS sous Windows

» Plus flexibles que les interfaces, tout en demeurant assez
simples dans leur syntaxe.

» Traitent une variété de fichiers (Access, .csv, etc.)

» Supportent les parametres de tables (KEEP=/DROP=,
RENAME= et WHERE=)

» Parameétres de tables: mot-clés placés entre parentheses, suite
au nom d'une table SAS lue ou écrite:

MERGE EDUC.PERS (IN=P OBS=20)
WORK.ASSIGN (IN=A) ;

¢ Haroy

2013-11-04
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3.1 Syntaxe de PROC IMPORT

PROC IMPORT DATAFILE="chemin-et-nom-du-classeur"

OUT=bibliothéque . table-SAS

DBMS=EXCEL
REPLACE;
RUN;

» Par défaut, la premiére feuille est lue

> Par défaut, les noms de colonnes deviennent les noms de

variables SAS

» Rappel: cette syntaxe n'est pas valide si SAS tourne en 64-bits

¢ Haroy

3.2 Exemple de PROC IMPORT

PROC IMPORT DATAFILE="c:\Seminaires\CUSQ\pers.xlsx"

OUT=work.importe
DBMS=EXCEL
REPLACE;
SHEET="PERS" ;
RUN;

[k VIEWTABLE: importe

MATRICUL | noMm |  DEPT  |POSTE| ANNEES | SALARE |  comm |
1 10 TANGUY 20 CADRE 7 12050.09 .
2 20 GATTAU 20 VENTE 8 3084.18 621322
3 30 ROBERT 38 CADRE 5 11506.75 .
4 40 OUDOT 18 VENTE 6 7641.14 5150.97
5 50 PARENT 15 CADRE 10 1685512 .
5 60 BAGET 38 VENTE 598661 3215.83
T 7N RINVFT 1R WVFNTF 7 R7Annd n

¢ Haroy

2013-11-04
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3.3 Autres énoncés de PROC IMPORT

» GETNAMES=NO; ignore les noms Excel de colonnes et
génere des noms de variables SAS (F1, F2, ...)

» RANGE=""cell-deb:cell-fin"*; lit une plage de cellules
» SHEET=""nom-feuille™; lit une autre feuille que la premiere

» MIXED=YES; est obligatoire, pour garantir qu'une colonne
contenant des nombres et des chaines devient une variable

SAS caractére

» DBSASLABEL=NO; empéche que les noms Excel de
colonnes deviennent les libellés de variables SAS

@ Haroy

3.4 Usage des énoncés supplémentaires

PROC IMPORT DATAFILE="c:\Seminaires\CUSQ\pers.xlsx"
OUT=work.importe
DBMS=EXCEL REPLACE;
SHEET="PERS";
RANGE="A2:F36";
GETNAMES=NO;
DBSASLABEL=NO;

RUN; 3
Bigh VIEWTABLE: importe
Fi F2 R | & | 8 F&
1 10 TANGUY 20 CADRE 7 1205009
2 20 GATTAU 20 VENTE 8 8084.13
3 30 ROBERT 38 CADRE 5 1150675
4 40 OUDOT 38 VENTE 6 7641.14
5 50 PARENT 15 CADRE 0 1685512
6 60 BAGET 38 VENTE : 5986.61
7 70 RINVFT 1R VFNTF 7 K740 4

¢ Haroy

2013-11-04
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3.5 Usage des parametres de tables

PROC IMPORT DATAFILE="c:\Seminaires\CUSQ\pers.xlsx"
OUT=IMPORTE (DROP=ANNEES
RENAME= (MATR=MATRICUL)
WHERE= (DEPT IN (10,38,42)))
DBMS=EXCEL REPLACE;
SHEET="PERS";

RUN; )
gl VIEWTABLE: IMPORTE

MATRICUL | NOM | DEPT  |POSTE| SALARE | comm |
1 30 ROBERT 38 CADRE 11506.75 .
2 40 OUDOT 38 VENTE 764114 6150.97
3 60 BAGET 38 VENTE 598661 3215.83
4 90 GUILLAUT 42 VENTE 724179 582743
5 100 LECLERC 42 CADRE 11736.88 .
6 120 CHANDAN 38 ADMIN 743359
7 130 JUVFN 47 ANMIN 5105 8

¢ Harpy

3.6 Syntaxe de PROC EXPORT

PROC EXPORT DATA = bibliotheéque.table-SAS
OUTFILE = '"chemin-et-nom-du-classeur"

DBMS=EXCEL
REPLACE;
RUN;

> Crée un classeur selon la version courante

> Par défaut, les noms SAS de variables deviennent les noms de
colonnes Excel

» Si le classeur existe déja, ajoute une nouvelle feuille
» Feuille nommeée par défaut selon la table SAS

@ Haroy

20



3.7 Exemple de PROC EXPORT

PROC EXPORT DATA=EDUC.PERS
OUTFILE="c:\exercices\pers.xls"

DBMS=EXCEL
REPLACE;
SHEET="PERS Exporté";
RUN;
h'—ﬁl_] Pers.xls [Mode de compatibilite]
A B & 0] E F G H
1 [hdATRICLANOR DEFT POSTE  ANMEES SALAIRE COMM
2 10 TANGLMY 20 CADRE 7 1206009
3 20 GATTAU 20 WENTE § 8084168 621322
4 30 ROBERT 38 CADRE 5 11506.75
B 40 oUDOT 38 WENTE 6 7E41.14 615047
6 50 PARENT 15 CADRE 10 1685512
7 60 BAGET 38 VENTE D956.61 321583
= 1R S/ERITE 7 R74ann4 il

¢ Harpy

3.8 Parametres supplémentaires

> LABEL dans I'énoncé PROC utilise les libellés (au lieu des
noms de variables SAS) comme noms de colonnes Excel

> Enoncé DBDSOPTS permet notamment de changer le type des
colonnes Excel créées

» Toujours les valeurs non-formatées qui sont écrites (sauf pour
les dates, heures et horodatages)

> Parametres de tables utilisables

> Pour créer un classeur d'une version antérieure, utiliser comme
valeur de DBMS= EXCEL5, EXCEL97, EXCEL2003, etc.

¢ Haroy

2013-11-04
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3.9 Emploi des parametres supplémentaires

PROC EXPORT DATA=EDUC.PERS (DROP=ANNEES
WHERE= (DEPT IN 10,20)))
OUTFILE="c:\exercices\pers.xls"
DBMS=EXCEL
LABEL
REPLACE;
SHEET="Pers avec libellés";
RUN;

2] Persxls [Mode de compatibilite]

- B e D E F G
Matricule de l'employé HOM Départemept POSTE SALAIRE COMM
0 TANGLUY DRE  12060,09

1

2

3 20 GATTAL NTE 808418 621322
4 B0 HEMRY 20 ADMING - 9210.41

5 160 BADIMOM pORE 3063522

B 180 JANIZZON 20 ADRIN 94364

7 210 REY 10 JADRE  15105.42

A 240 AR 10 yanEFE - 13074 79

-4 » b | PERS_Exporté

¢ Harpy

PERS_avec_libellés ).

4. Enoncé LIBNAME - la révolution!

> Classeur Excel alloué et traité comme si il s'agissait d'une
bibliotheque SAS, contenant une ou plusieurs "tables"

» Chaque feuille du classeur et chaque zone définie dans le
classeur est traitée comme une table SAS

> S'utilise avec toutes les versions des classeurs Excel, dans les

environnements Windows, UNIX et Linux

» Lecture et écriture permises - pas nécessaire "d'importer"” les

données en SAS pour les traiter!

@ Haroy

2013-11-04
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4. Enoncé LIBNAME - la révolution! (suite)

> Pour connaitre le nom des feuilles du classeur, utiliser
I'explorateur SAS ou la procédure CONTENTS

» Toutes les procédures acceptant une table SAS en entrée ou en
sortie peuvent se lier a un classeur Excel: SORT,
SUMMARY, TABULATE, REPORT, GLM, SQL,
GCHART, IML, etc.

» Permet d'écrire dans une feuille Excel pré-formatée (un
"gabarit™)

» Le classeur peut demeurer ouvert pendant la lecture

¢ Harpy

4.1 Syntaxe de I'énoncé LIBNAME avec Excel

LIBNAME surnom EXCEL

"chemin-et-nom-du-classeur";

» Une ou plusieurs étapes DATA ou PROC suivent LIBNAME:
« effectuer directement des analyses,
* importer les données dans une table SAS
* exporter une table SAS vers une nouvelle feuille

» Deés que le classeur n'est plus utilisé, le désallouer via:

LIBNAME surnom CLEAR;

@ Haroy

2013-11-04
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4.2 Exemple de traitement d'un classeur Excel

LIBNAME LIEN EXCEL "C:\SEMINAIRES\CUSQ\Pers.xlsx";
PROC PRINT DATA=LIEN.PERS (RENAME= (MATR=MATRICUL)
DROP=ANNEES) ;
ID MATRICUL;
WHERE DEPT IN (10,38,42);
RUN;

> Variables renommées et sélectionnées,
> Observations filtrées

» Aucune table SAS intermédiaire requise

¢ Harpy

4.2 Exemple de traitement d'un classeur (suite)

MATRICUL | NOM DEPT POSTE SALAIRE COMM
30 | ROBERT 38 CADRE 11506.75
40 | ouDOT 38 VENTE 7641.14 615097
60 | BAGET 38 VENTE 5986.61 3215.83
90 | GUILLAUT 42 VENTE 724179 582743
100 | LECLERC 42 CADRE 11736.88
120 | CHANDANS 38 ADMIN 7433.59
130 | JUVEN 42 ADMIN  995105.80
4180 | BADIMON 1N CADRE ANR3A 22

¢ Haroy
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4.3 Autres traitements avec une feuille Excel

» Avec I'énoncé LIBNAME, beaucoup des fonctionnalités SAS
de traitement des tables sont possibles:

* importer la feuille pour en faire une table SAS, par une simple étape
DATA

+ consulter la liste des feuilles: la procédure CONTENTS ou la fenétre
Explorer

« éditer les données d'une feuille (fenétre ViewTable, fenétre FSVIEW,
énoncé MODIFY ou UPDATE, etc.)

* insérer un énoncé BY dans I'étape qui traite la feuille: sans utiliser la
procédure SORT, Excel retourne les rangées dans I'ordre!

« jointure entre une feuille Excel et une autre source de données (fichier
SPSS, base de données MS-Access, autre feuille Excel, etc.)

¢ Harpy

4.3 Autres traitements avec une feuille (suite)

» Probléme en vue;

* le nom de la feuille est fourni de la méme maniére qu'un nom de table
SAS dans DATA,

« comment donc traiter les feuilles dont le nom ne suit pas les conventions
SAS (exemple: Employés revenus )?

» Placer le nom de la feuille entre guillemets, suivi de N - SAS
reconnait alors qu'il s'agit d'un nom SAS non-standard

¢ Haroy
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4.3 Autres traitements avec une feuille (suite)

DATA IMPORTE REV;
SET LIEN."Employés revenus'"N;
BY DEPT MATRICUL;
HEBDO=REVENU_ ANNUEL /52;
FORMAT HEBDO NLNUMS9. ;

RUN;

LIBNAME LIEN CLEAR; VIEWTABLE: importe_rev

MATRICUL| NOM | DEFT | REVENU_ANNUEL | HEBDO |
1 160 BADIMON 10 59674280 1860
2 210 REY 10 4770133 917
3 240 JOURDA 10 54128881 74
4 260 HUBACHER 10 57475406 1438
5 50 PARENT 15 $5322669 1024
6 70 RINVET 15 §18.12644 49
7 110 FILLON 15 §2194620 422
B 170 ROULIN 15 S2055764 395
3 10 TANGLY 20 53305282 732
10 20 GATTAU 20 S4514968 868
11 on UCKMDV W 70 NOE R EEQ

¢ Harpy

4.4 Parametres complémentaires avec LIBNAME

» LIBNAME dispose de parametres qui améliorent sa
flexibilité et s'appliquent a toutes les feuilles, dont:

* GETNAMES=NO ignore les noms Excel de colonnes et génére des
noms de variables SAS (F1, F2, ...)

+ DBSASLABEL=NO suspend la création de libellés de variables

 DBGEN_NAME=SAS contrble le remplacement des caractéres

spéciaux (accents, symboles, etc.) dans les noms de colonnes Excel
utilisés comme noms de variables SAS

* MIXED=YES garantit qu'une colonne contenant des nombres et des
chaines deviendra une variable SAS caractere, avec les nombres
convertis - en son absence ...

@ Haroy

2013-11-04
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4.5 Parametres fournis avec la feuille

» D'autres paramétres sont spécifiques a la feuille:

» Pour lire une plage de cellules dans une feuille, faire suivre
le nom de la feuille d'un symbole $ et des cellules de début
et de fin de la plage - par exemple:

SET LIEN."PERS$A2:F36"N;

* DBSASTYPE-= est un parameétre de table qui permet de
changer le type de la variable SAS creée (numérique,
caractere, date, heure, etc.)

+ DBGEN_NAME= et DBSASLABEL peuvent étre fournis
comme parametres de table, et n'affecter qu'une feuille

¢ Harpy

4.6 Exemple de parametres

LIBNAME LIEN EXCEL "C:\Seminaires\CUSQ\PERS.xlsx"
GETNAMES=NO DBSASLABEL=NONE;
PROC PRINT
DATA=LIEN."PERS$A2:F36"N (RENAME= (F3=DEPT) ) ;
BY DEPT;
ID DEPT;
RUN;
LIBNAME LIEN CLEAR;

DEPT| F1 F2 F4 F5 F6

10 | 160 BADIMON CADRE 7 30635.22
260 HUBACHER CADRE 12 23672.12
210 REY CADRE 10 15105.42
240 JOURDA CADRE 5 13074.79
15 | 170 ROULIN ADMIN 4 650992
50 PARENT CADRE 10 16855.12

0 HarDy 70 RINVET VENTE 7 5740.04

2013-11-04
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4.7 Ecriture dans Excel via I'énoncé LIBNAME

» Ajouter une feuille a un classeur existant se fait directement -
le nom proposé pour la feuille n'est pas toujours respecte.

» Remplacer le contenu d'une feuille existante exige d'abord de
détruire celle-ci (via la procédure DATASETS):

LIBNAME LIEN EXCEL "C:\EXERCICES\Pers.xls";
PROC DATASETS LIBRARY=LIEN NOLIST;
DELETE "PERS_Exporté"N;
QUIT;
DATA LIEN."PERS Exporté"N (DROP=ANNEES
RENAME= (COMM=COMMISSION)
WHERE= (DEPT IN (10,20)));
SET EDUC.PERS;
RUN;

¢ Harpy

4.8 Parametres pour |'écriture via LIBNAME

> DBLABEL=écrit les libellés SAS de variables comme noms
de colonnes Excel (parametre de table)

» DBTYPE-= altére le type des colonnes Excel créées
(parametre de table)

» SCAN_TEXT= vérifie la longueur des chaines du classeur
Excel (dans LIBNAME, spécifier NO si une mise-a-jour du
classeur sera nécessaire)

» VERSION= indique la version du classeur créé (dans
LIBNAME)

@ Haroy

2013-11-04
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4.8 Parametres pour I'écriture via ... (suite)

LIBNAME LIEN EXCEL "C:\EXERCICES\PerS_2003.Xls"
VERSION=2003;

PROC DATASETS LIBRARY=LIEN NOLIST;
DELETE "PERS avec libellés"N;

QUIT;

DATA LIEN."PERS avec libellés"N(DBLABEL=YES) ;
SET EDUC.PERS;
LABEL MATRICUL="Matricule de 1l'employé"

DEPT ="Département";
RUN;
LIBNAME LIEN CLEAR;

@ Haroy

4.8 Parametres pour I'écriture via ... (suite)

A E = D E F i H
Matricule de 'employe YOM OSTE ANNEES SALAIRE COMM
0T

1

2 ANGLY 20 CADRE 7 1206009

3 20 GATTALU 20 YENTE G 808418 621322
4 30 ROBE AT 38 CADRE 5 11506.75

= an N InnT 0 WENTE R 7R41 14 RIEN Q7T

» Ne pas se préoccuper du message suivant dans le journal, qui
indique faussement que les libellés ne seront pas écrits:

003 RUN;
I0TE: SAS variable labels, fqrmats, and lengths are not written to DBMS tables.

¢ Haroy

2013-11-04
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4.9 Ecriture dans un "gabarit"

» Gabarit - feuille Excel avec mise en page soignée:

A B c D E F G

1 RAPPORT DE FREQUENTATION TOURISTIQUE PAR REGION D'ORIGINE
2 Période finissant le: 31121900

3

4 | Origine des voyageurs | Hiver | Printemps | Eté
5 MNombre % Nombre % Nombre %
6

T

8 |Québec

9 Moins de 250 kilométres

10 250 kilométres ou plus

1 TOTAL Québec

12 | Ontario

13 |Maritimes

14 |Ouest

15 |TOTAL Canada

16

17 \Mouvelle-Angleterre

18 |Mid-West

19 | Californie
20 | TOTAL Etats-Unis
21
22 |France

27 [RAuanmad Ini

4.9 Ecriture dans un "gabarit" (suite)

» Données peuvent étre écrites dans diverses zones de la feuille:

A B C D E F G H | J

1 RAPPORT DE FREQUENTATION TOURISTIQUE PAR REGION D'ORIGINE

Z Période finissant le:| 2002-12-;

3

4 | origine des voyageurs | Hiver | Printemps | Eie | Automne. |
5 Nombre % Nombre % Nombrem % Nombre %

6

T

8 | Québec

9 | Moins de 250 kiometres 12857 5,39% 148655 11,87% 265 890 9,95% 121890 12,29%
10| 250 kiométres ou plus 21349 5,10% 137 908 11,10% 301 554/ 11,32% 118594 13,07%
11 TOTAL Québec 34008 14,48% 286 561 23,07% 567 444 21,31% 240884 26,45%
12 | ontario 38566, 16,43% 194 567 15,66% 478321 17,96% 201532 22,13%
13 Mariimes 1342 0,57% 22875 1,84% 37654, 1.41% 15679 2,05%
14 |Ouest 22455 9.57% 258678 2,07% 157 583/ 5,92% 26785 2,94%
15 | TOTAL Canada 96369 41,07% 529681 4264% 1241012 46,61% 487 880 53,58%
16

17 Nouvelle-Angleterre 38678 16,81% 201324 16,21% 288 768 14,88% 121376, 13,33%
18 | Mid-West 15682 668% 124650 10,03% 301878 11,34% 74522 8,18%
19 | Calfornie 6893 2,98% 109876 8,85% 245607 9,22% 63900 7.57%
20 | TOTAL EtatsUnis 105035 44,76% 624837 50,31% 1268139 47,63% 340 482 37,38%
21
22 |France 14501 8,18% 17 830 1,44% 29974 113% 22348 2,45%
23 | Royaume-Uni 2335 1,00% 9569 0.77% 14886 0,56% 7654 0,84%
24 | Alemagne 1675 0.72% 8763 0.71% 12902 0,48% 5476 0,60%
25 talie 1134 0,48% 12845 1,03% 18 965 0.71% 11327 1,24%
26 |TOTAL Europe 29592 1261% 64519 519% 99784 375% 63525 6,98%
pid
28 |Japon 1532 0,65% 9756 0,79% %782 1,01% 6235 0,68%
29 | Hong-Kong 1147 0,49% 7894 0,64% 15670 0,59% 7874 0,85%
30 | TOTAL Outre-Mer (sauf Europe) 3672 1,56% 23081 1,88% 53801 2,02% 18676 2,05%

1

234 868 100,00% 1242 218 100,00% 2662 736 100,00% 910 563 100,00%

30



5. Couloir SQL d'instructions

» Technique courante avec les bases de données relationnelles -
aussi nommeée "pass-through facility"

» Remplace I'énoncé LIBNAME par un énoncé CONNECT
TO EXCEL dans la procédure SQL

» Les parametres de I'énoncé LIBNAME avec le moteur Excel
peuvent étre fournis dans la parenthese de I'énoncé
CONNECT TO

» Nom de la feuille fourni entre accolades, incluant la plage de
cellules lues si nécessaire

> Expédie les instructions de traitement directement a Excel
plut6t que de tenter lui-méme de les exécuter

¢ Harpy

5. Couloir SQL d'instructions (suite)

PROC SQL DQUOTE=ANSTI;

CONNECT TO EXCEL
(PATH="C:\Seminaires\CUSQ\PERS.x1lsx"
GETNAMES=NO DBSASLABEL=NONE) ;

CREATE TABLE IMPORTE AS

SELECT * FROM CONNECTION TO EXCEL
(SELECT * FROM [PERSS$A2:F36] );
DISCONNECT FROM EXCEL;
QUIT;

@ Haroy

2013-11-04

31



2013-11-04

6. Lien ODBC (Open DataBase Connectivity)
» Alternative a I'emploi de LIBNAME ou du couloir SQL
d'instructions (“"pass-through facility™)

» Offre virtuellement les mémes fonctionnalités que les
précédents

» Utilise le module SAS/ACCESS for ODBC, ce qui donne
acces a un trés grand nombre de sources de données

» Disponible sous Windows, UNIX, Linux

» Performances parfois moindres que les liens SAS/ACCESS
natifs

¢ Harpy

7. Tagset ExcelXP
» Tagset ExcelXP est une destination ODS, comme PDF ou
HTML
» En production depuis la version 9.1

» Crée un document XML, que Excel (version 2002 ou apres)
relit sans peine

> Etonnant contrdle dans la mise en pages
» Aucun recours a un gabarit existant
» Autres tagsets: MSOffice2k, RTF, etc.

@ Haroy
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7.1 Attributs de mise en page utilisables

» Largeur et hauteur des cellules, couleur du fond

» Couleur, taille et polices de caracteres

» Formatage conditionnel (“traffic-lighting")

» Commentaires attachés aux cellules

» Trame de fond contrastante a toutes les n lignes

> \olets figés, filtres automatiques, niveau de zoom

> Formules dans les colonnes

» Paramétres d'impression

> Etc., etc., etc. ...

¢ Haroy

7.2 Exemple (fonte, alighement, lignes de bris)

Expenses
Class Pctg. Bud. vs as of April
3 School name D Capacity Exp. Budget 20
4 Dekker a1 28 99,0 % 18550 5 187335
5 a2 12 24,5 % 14400 5 16 980
6 43 30 101,7% 21350 5 20989 §
o A5 28 100,0 % 20100 5 200918
g 3 27 99,3 % 17 900 § 18 026 5
9 a7 28 99,5% 127505 198445
10 SUB-TOTAL 161 1120506 [ 1146635
11
12
13 [Lancaster 01 29 876% 20 450 5 23338 S
14 02 30 24,6 % 214505 226755
15 03 29 1038 % 20 750 § 199925
16 04 31 100,6 % 22 600 $ 22 458 S
17 SUB-TOTAL 119 85 250 & 88 463 §
|18}
19
20 Saint-John [i]] 28 104,7 % 18150 5 17330 5
21 02 26 99,0 % 16 850 S 170225
22 na 26 88,1% 17 150 § 19 456 5
23 05 27 939 % 17 500 § 186355
24 o7 28 100,6 % 12800 5 196795
25 SUB-TOTAL 135 89 450 & 92 1225
|26
7Harpy |;
71 IR &I 28 [TOTAL 415 286 750 5 [ 295 2485 |

2013-11-04
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7.2 Exemple (volets, filtres, format. cond.)

Zl Rep4_1B.xls

M 4 » wm\Financial Results

B a8 53, a% 17 900 § tsczss
9 AT 28 99,5 % 19750 § 19 844 5
10 SUB-TOTAL 161 112050 § H
1

1]

13 |Lancaster 01 29 [ 87,6% | 20450 §

14 02 30 24,6 % 21450 § 22 6155
15 03 29 207505 | 199925
16 04 31 100,6% | 22600% | 224585
17 [SUB-TOTAL 119 | [ 852505

18|

>

20 |saint-John o1 28 181505 | 17330
2 02 26 59,0% | 168505 | 170225
2 04 26 88,1 % 171505 3439 456 5
23 05 27 93,9% | 175005 | 186355
24 o7 28 100,6 % 19 800 § 19 679 5
25 [SUB-TOTAL 135 89450 S h

|

3

%

7.2 Exemple (masquage et formules)

“Harby

EHESm ELRY FRE-F| - o8 2 -2 il o

Affichage

Eichier

Edition

-2 Tre

A D E F G H

Employee Total Salary as %

1 |Departmen - ID Salary [Commission| revenues |of revenues

2 |10 B DI ON-160 \@ 306358 0635 % 100,0 %

3 REY-210 15105 § 15105 § 100,0 %

4 JOURDA-240 13075 % 13075 % 100,0 %

5 HUBACHER-260 23672 S 23672 § 100,0 %

E |15 PARENT-50 16 855 § 16 855 § 100,0 %

7 RINVET-70 5740 § 03 5740 % 100,0 %

g FILLON-110 6950 § 6950 § 100,0 %

9 ROULIN-170 6510 5 65105 100,0 %

10|20 TANGUY-10 12050 § 12050 § 100,0 %

1 GATTAU-20 5084 § 62135 14297 § 56,5 %

12 HENRY-80 3210 5 9210°§ 100,0 %

13 JANISSON-150 99355 9935 § 100,0 %

14|38 ROBERT-30 11 507 & 11 507 § 100,0 %

2013-11-04
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7.2 Exemple (feuille nommée par var. de bris)

=10)x]

| B c D El =
1 School Dekker =
2 Schoal Lancaster
3 School_Saint-John
4 41
5
&
; A B C D
3 1 | Financial report for each school
10 2 L]
1 3 CLASS CAPACITY BUDGET| EXPENSES F
12 41 pe] 2045000 § 7333800 §| i
131 - <
HEARFIRD, Contents [Tl RETa 5 2 30 21 450,00 § 22 675,00 §| 7
6 |3 Fe] 20750,00 § 19 99200 §| i
74 3l 2260000 % 22 455 00 §) I
8 _|Number of classes: 4
9 PN
10
W %
12 I R
W 4 ¢ m\ Contents J/ School Debker ) School Lancaster  School 2|4

@ Haroy

7.3 Avec quel outil écrire?

> Les mémes que pour autres destinations ODS: les
procédures + étape DATA

» En pratique, privilégier dans l'ordre:
* Procédure REPORT
* Procédure TABULATE
+ Enoncé PUT dans DATA
* Procédure PRINT
* Procédure SQL

@ Haroy
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7.4 Premieére utilisation

ODS LISTING CLOSE;
ODS TAGSETS.ExcelXP PATH="D:\RAPPORTS\"
FILE="Rep4_3.xls"
STYLE=SANSPRINTER;
PROC PRINT DATA=EDUC.EXPENSES LABEL;
BY SCHOOL;
ID SCHOOL;
FORMAT RUDGET EXPENSES DOLLARI11.
CAPACITY 4.1;
. suite-de-la-procédure ...
RUN;
ODS TAGSETS.ExcelXP CLOSE;
ODS LISTING;

¢ Harpy

7.4 Premiére utilisation (suite)

» Nom de feuille est déterminé par défaut (Table 1 — Data Set
Educ.Expenses ici)

» Format DOLLARLL. fait en sorte que Excel recoit les variables
visées comme étant de type monétaire

» Format exact Excel est ensuite assigné selon le parametre
régional Windows

» Méme logique pour CAPACITY
> Libellés de variables = noms de colonnes

¢ Haroy

2013-11-04
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7.4 Premiere utilisation (suite)

> Classeur créé par tagset, avec style SANSPRINTER - vous avez
ma parole, aucune retouche a la main!

O Rep4_3.xls

@ Harpy

A B C D E F

i |Schoolname |[Class ID Cagaci_t!] Budget| Expenses as of April 20
2 Dekker Al 23| 1855000 % 1673300%
3 A2 19| 1440000 § 16 980,00 §
4 A3 30| 21350,00 § 2098900 §
5 A5 29| 2010000 § 2009100 %
6 45 27| 17900,00 §) 16 026,00 §
7 AT 28| 1975000 § 19844,00 §
8 Lancaster 1 29| 20450009 23338008
9 2 30] 21450,00 §) 2267500 §
10 3 29| 2075000 § 1999200 §
1 4 31| 2260000 § 2245800 §
12 |Saint~John 1 28| 1815000 § 17 330,00 §
13 2 26| 16850,00 §) 17 02200 §
14 4 26| 17 150,00 § 19 456,00 $
15 5 27| 1750000 § 18635,00 §
16 7 28] 19800,00 §) 1967900 §
17
el PN

8.1 Procédures ACCESS et DBLOAD

» PROC ACCESS pour lire, PROC DBLOAD pour écrire

» ACCESS exige la création de deux fichiers SAS: un
"descripteur ACCESS" puis une vue

» Vue employée ensuite comme une table SAS — peut servir a

mettre a jour le classeur

» Méthode qui continue d'étre supportée, mais qu'il faut délaisser

le plus tot possible:

» nouveaux formats de classeurs Excel non-supportés
* bogues ne seront pas nécessairement corrigés
+ aucune fonctionnalité qui n'est pas disponible autrement

¢ Haroy
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8.2 DDE (Dynamic Data Exchange)

» Lecture / écriture directe dans cellules d’une des feuilles
» Limité a I'environnement Windows

» En plus de Excel, disponible aussi avec Word et Access;
> Etape DATA comme modalité d’interfacage

» Permet d'écrire dans une feuille préformatée ("gabarit")

> Microsoft tente de se débarasser de cette technologie - il est
plus prudent de "quitter le navire"

¢ Harpy

8.3 ODS (Output Delivery System) HTML

* ODS peut transformer tout résultat imprimable en
fichier HTML.

» Un fichier HTML peut étre lu directement par Excel.

* On peut donc utiliser des procédures telles que PRINT,
REPORT ou TABULATE pour créer un classeur Excel!

¢ Haroy
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CONCLUSION

» Grande diversité de méthodes

> Interfaces pointer-cliquer limités, mais Import data dans
Enterprise Guide est de loin le plus flexible

» Meéthodes les plus flexibles et qui offrent le meilleur avenir:
> Enoncé LIBNAME avec moteur Excel
» Tagset Excel

» Deux tableaux-synthése a la fin de votre document comparent
les diverses méthodes

¢ Harpy

POUR PLUS D'INFORMATIONS

Jean Hardy
Services Conseils Hardy Inc.

418-626-1666
thardy@schardy.qc.ca
Web: www.schardy.gc.ca

@ Haroy

2013-11-04

39


mailto:jhardy@schardy.qc.ca
http://www.schardy.qc.ca/

